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The A/E/C Work Structure - User’s Guide

Forward

The A/E/C Work Structure is a working environment, configured to assist the designer to efficiently and
effectively assemble their drawings and to follow the A/E/C Standards developed by the CAD/BIM
Technology Center. Every item in the work structure has been reviewed and corrected for size, shape
and symbology to follow the A/E/C Standards. The A/E/C Work Structure is configured to operate along
side of the default datasets delivered by the CAD-BIM software vendors. This allows CAD-BIM managers
the flexibility to install minor version releases for updates & bug fixes, while providing full functionality
for new releases without reconfiguring the A/E/C Work Structure or waiting for a new version to be
developed.

It is our hope that you will find this work structure more effective than the previous workspaces. It is our
goal to enhance the A/E/C Work Structure in order to make it easier to use, more efficient and effective.
Please share your comments with us by filling out and submitting the Change Request, Issue Report and
Evaluation Form located on the last page of this document. Comments, Concerns & Recommendations
(CCRs) always welcome.

Note:

Updates to the Work Structure will delete and replace the entire Standards folder structure, the entire
AEC_WS _001_ProjectTemplate folder structure, and the AEC_WS_001_ProjectTemplate.pcf file. DO
NOT modify these items. Changes to these will be lost on a future update.

The Work Structure Committee — Structure Team (WSC-ST)

Definitions

Workspace: A collection of datasets, extensions, folder structures, and files combined to create a
consistent common working environment.

Dataset: A predefined collection of data files.

Extension: Data files that extend the capabilities of the dataset beyond what was delivered.

Project: The CAD/BIM/CIM file folder structure that holds the design and support files for a

specific drawing set as defined by the Project Template. The Project Template is
delivered in the Workspace/Projects folder.

Master Format: A standard for organizing specifications and other written information for commercial
and institutional building projects in the U.S. and Canada.

TOC: In the upper right of many pages, you will see TOC . This is a link to the Table of
Contents in this document.

A/E/C Users Guide June 2016 1



Note:

All content follows the workflows as outlined in the A/E/C CAD and Graphics Standards or as defined in
the A/E/C Work Structure accompanying documentation. The use of 3D design models referenced to 2d
Drawing models, annotated to represent a specific Plan, Profile, Section, or Detail and the 2d Drawing
models referenced to a full size sheet models is critical for the automation to work correctly.

A/E/C Users Guide June 2016
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Executive Summery

The following is a short list of the features included in the Work Structure.

1. The Work Structure is designed around a common theme to supplement the delivered
content from software vendors without taking over complete control of it.

2. The dataset uses MasterFormat division numbers, full descriptions and major to minor
category groupings.

3. The Line Styles, Cells/Block libraries, and Parts/Families:
a. Reduces duplications, improves consistency and provides a greater ease of use.

b. Consistently sized based on increments of 3/32” and are resizable based upon
annotation scale.

4. The Work Structure files are organized into three main categories:
a. The Common dataset contains items required by all software.
b. The Horizontal dataset contains items required for InRoads.
c. The Vertical dataset contains items required for AECOsim Building Designer.

5. Annotation Styles are set to 3/32” text height for common text and 3/16” for Titles, in the
Arial font, and either Masked or Unmasked.

6. The Levels are a complete list of those found in the A/E/C CAD Standard with settings now
reflecting more appropriate field use colors.

7. Tasks and Templates are defined to aid users in the placement of items according to the
A/E/C CAD Standards.

8. All content (e.g. Cells, Styles, etc.) has been evaluated and has the Units of Resolution (UOR)
consistently set to 304800/Survey Foot. Multiple macros are included to assist users.

9. The Project Folder Structure substantially remains intact from the TS_WS_001 workspace.

10. An Extensions folder is provided for agencies to add localized content to the Work Structure.

A/E/C Users Guide June 2016 3
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What is in the Work Structure and why is it there?

Documentation

The “Docs” folder contains documentation on the A/E/C Work Structure, A/E/C CAD and Graphics
Standards.

Corporate Dataset

The Corporate Dataset folder, “Workspace\Standards”, contains all of the A/E/C Standards settings files
and datasets. This folder shall be considered READ ONLY. Any modifications made in this folder will be
DELETED in future updates.

The Standards folder contains two sub folders for Autodesk and Bentley datasets.

Bentley Folder Structure EI"L":' Standards
- cel --1_, Autodesk
. . . . i =" Bentley
This folder contains the Cell libraries and Cell Selector files. L cel
Cell libraries M- ZD:ﬂg
The library files are organized by Master Format Division number I:—:ILL: d:t:5et5
and the Cell names are based on the Master Format section it "L.' ACAD
would be found in. The Cell descriptions are expanded to give a "L.' Horiz
better indication of what the cell is. The symbol Cells are sized to "L.' Metric
use an annotation scale based on a multiple of 3/32" (e.g. "L.' Vert
2x3/32” high by 4x3/32” wide). Object Cells are sized so they can ,
) . o =i+ dgnlib
be scaled to true size objects by utilizing a scale factor. All Cells -7 Annotation
have been recreated using a Unit of Resolution (UOR) of 304800 " DisplayStyles
per survey foot, the same as all files in the dataset. Some of the [ DV Seed
Cell libraries are quite large, so it will be beneficial for designers ___L'— LE\.:els
to become familiar with the A/E/C Symbols Guide in the Docs __1"_ NamedExpressions
folder. Cell Selector menus will also assist designers in selecting LL: Stanu:laru:l::hecker
the Cells graphically. [ Tasks
Cell Selector files M w;:l:pps
The Cell Selector menus were created for visual selection of "._L’ Se;dg
Cells. They either set the Cell as the Active Cell and/or the Active ____1" cvmb
Pattern. Cell Selector menus can be accessed from the AEC pull- LL: \_i;a

down menu (AEC Menu -> Tools -> Cell Selector).

- config
This folder contains the configuration files control loading of software.

- data
This folder contains the color tables, xml and definitions files.

A/E/C Users Guide June 2016 5



Color Tables

The color tables have been reset to reflect the colors found in Table 3-4 of the A/E/C CAD
Standards.

TOC

1. AEC_ColorTable3-4 B&W.tbl - For use with IPlot.
2. AEC_ColorTable3-4.tbl - For CAD files

- datasets

ACAD

This folder contains the dataset for supporting MicroStation in DWG work mode.

Horiz
This folder contains the dataset for supporting Horizontal design software (Civil).

Metric
This folder contains the dataset for metric mode for both Autodesk and Bentley software.

Vert

This folder contains the dataset for supporting Vertical design software
(Architectural/Structural/MEP).

- dgnlib

Annotation

This folder contains the Text/Dimension and Detail style libraries.

DisplayStyles

This folder contains the Display Styles library. The 5 Display Styles are named based on the screening
values from 20% to 60% in 10% increments.

Levels
This folder contains all of the A/E/C level libraries.

Level library features:

1. Alllevels as defined by the A/E/C CAD Standards.

2. Colors are based on RGB values to reflect what is used in the field (i.e. APWA color codes for
utilities) and to be more consistent standard for both AutoCAD and MicroStation files.

3. Contains level filters based on file types.

NamedExpressions

This folder contains the NamedExpressions library. One of the uses includes parsing the file name to
determine what discipline and model file type is used and sets the Tasks menus accordingly.

A/E/C Users Guide June 2016 6



TOC
Tasks

This folder contains the Task libraries. The task menus are set up to help the user select the correct
level and set the correct styles for the work they are performing. The task menus have been updated
to reflect the changes in the level standards and to guide the user in placing the correct items with the
proper file type. Additionally, to reduce the number of mouse clicks a person would have to press to
perform common tasks, the general tasks have been placed under all task menus along with the
common drafting tools.

1. The Task menus load automatically by design file name.
2. Each Task menu loads General tasks and Drawing tools for easier access to common items.
3. Task Menus can be opened via an A/E/C pull down menu.

- MDLApps
This folder contains commonly used applications/programs developed using MicroStation
Development Language (MDL).

- pltcfg
This folder contains default plotting configuration files.

- seed

This folder contains the seed files for new design models and drawing models. The seed files have all
been updated to use common Units of Resolution (UOR). Since GeoPAK uses the UOR for its primary
setting, and Bentley AECOsim Building Designer (ABD) requires a high resolution setting for dynamic
views, the setting was changed to 304800/Survey Feet (SF). This setting is extremely close to the
previous 1000000/Meter setting. Testing revealed no significant changes to previous files.

The seven (7) seed files provided are:

1. AEC_DesignSeed_Horizontal.dgn - Civil, Survey, Landscape, GeoTech ... 3D Model
Used for the 3d models of surface and sub-surface design.

2. AEC_DesignSeed_Horizontal_2D.dgn - Civil, Survey, Landscape, GeoTech ... 2D Model
Used for the 2d models of surface and sub-surface design (Intended for use with InRoads).

3. AEC_DrawingSeed_Horizontal.dgn - Civil, Survey, Landscape, GeoTech ... 2D Model
Used for referencing the Horz. 3d models, annotation for Sections, Profiles, Plans, and Details.

4. AEC_DesignSeed_ Vertical.dgn - Arch, Struc, MEP, ... 3D Model
Used for the 3d models of surface and sub-surface design.

5. AEC_DrawingSeed_Vertical.dgn - Arch, Struc, MEP, ... ... 2D Model
Used for referencing the Vert. 3d models, annotation for Sections, Profiles, Plans, and Details.

6. AEC_Cell_Seed.cel - Cell library for project, site and or local extensions

7. AEC_Seed.dgnlib - DGN library for project, site and or local extensions

- symb
This folder contains the Line Style resource files.

- vba
This folder contains the Work Structure Visual Basic program extensions.

A/E/C Users Guide June 2016 7



Autodesk Folder Structure :
B Standards

- Blocks B Autodesk
This folder contains ACAD block libraries EIL' %CAD
--1___ Blocks
- data 1" data
This folder contains the AEC_Open.dws file. 1" LineType
Ll PlotStyle
- LintType LT Template

This folder contains the Line Types resource file.

- PlotStyle
This folder contains the AEC_B&W.stb file.

- Template
This folder contains the AEC_Horiz and AEC_Vert.dwt files.

A/E/C Users Guide June 2016



Sheet Set Manager

A template file for Sheet Set Manager has been added to the Template project 01_Gen \ Drawings

folder. It contains first and second level designators for plot file order and Title Block information is now

tied to the Sheet Set with fields.
For multiple facilities or

=L Workspace
- Extensions
=L Projects

vamie

o/ TR AEC_SheetSet.dst
A A 2EC_TitleBlock_ANSI_A.dgn

volumes copy, rename, and use S AEC_WS_001_ProjectTernplate ?%AEC_TideBIock_ANSI_A.dwg
L o7 ; AEC_TitleBlock_AMNSI_B.dgn
. =L ProjectData - - AN _b.dg
the new sheet set manager file. B0 CAD_BIM 7 53 AEC_TitleBlock ANSL B.dwa
{: _M aste r_Mo dels /. AEC_TiHeBIuck_ANﬂ_D.dgn
[ _Sheets # PR AEC_TitleBlock_ANSI_D.dwg
El'{: 01_Gen /. AEC_TitleBlock_AMNSLE.dgn
__[:f Drawings # P AEC_TitleBlock_ANSI_E.dwg
-0 02_HazMat A BAAEC TitleBlock_ANSLF.dgn
- 03 _SurvMap # I8 AEC_TitleBlock_ANSI_F.dwg
@5 04 Geatech /B EC_TitleBlock 1SO_ALdgn
©-L7 05 Civil # IR AEC_TitleBlock_ISO_ALdwg
(¥ D6_Lndscp
x Name AEC_SheetSet.dst
13 IAEC_ShtttS&‘I.dSt '] % '& = TE -] Sheet set data file e ove - vk pravp S 0kan.mark.ds.usac e army,
& = Description AJE/C Standards Sheet Set
Sheat: = Model view ci\bentley_work\pa_working\g6irxrifice...
& AEC_SheetSet.dst N Label block for views
: g 2 ol B Callout blocks
@% General Page setup overrides file
& Hezardous materil ot e
@I Sumy_hf'lapping B Project number
@‘I Geotechnical Project name
i . Project phase
EI.I@ Civil o . é Project milestone
o) P demoliden 5| | [ ventcmpmpopete e
- Ely - ai Ciily = AEC_CHECKER J. CHECKER
@] C3 (Civil site) AEC_DES_1_MAME DESIGM FIRM MAME
Ely ¢6 (Civil grading) AEC_DES 2 ADD DESIGN FIRM ADDRESS 2
) CT (Civil transportation) AEC_DES_3_CITY DESIGN FIRM ADDRESS 3
M ) AEC_DES 4 ADD DESIGM FIRM ADDRESS 4
Eil_l] CP {Civil paving) 5 AEC_DESIGNER ), DESIGNER
CEl) cu (Civil utilities) iz AEC_DRAWER J. DRAWER
-l cI{Chil improvernents) = 5 AEC_SHT_TITLEL SHEET TITLE 1
El'_l] CB (Civil beach renourishment) zm AECESHISIIEES SHEET TITLE 2
! i AEC_SHT_TITLE3 SHEET TITLE 3
E_'_I] CE (Civil ecosystern restoration) AEC_SUBMITTER 1. SUBMITTER
-8 CF (Cwilflood control) T
E_I_I] CH {Chvil shore protection) Sheet storage location praeiic 0 g - rark parp S0kan. k. ds.usace army,
~Elj cM (Civil navigation) Shestrastionimplate
1 €O (Chl operation and malntenance e —
@] CR (Civil recreation) AEC_BLDGID BLDG-ID
) Cx (Civil security) AEC_HOST_AG DISTRICT
1 &) Landscape AEC_HOST_AG_ADD1 ADDRESS
@8 structural AEC_HOST_AG_ADD2 CITY, STZIP
) AEC_MAN_CONTRNUM | 300000(-30(-X-)000(
. w8 A":hlf“':twa' AEC_MAN_DATE MMMMMMMMM YYYY
E‘ 1+ B Interiors AEC_MAN_OPTITAG %OPTIONAL FIELD 1%
i @..% Fire Protection b AEC_MAN_OPT2TAG %0PTIOMNAL FIELD 2%
@) Plumbing AEC_MAN_SOLICNUM JOODOXH-HH-X-I000C
3 ; AEC_PROJ_1LOCATION  |PROJECT/CONTRACT LOCATION 1
§ 2] % Mechanical AEC_PROJ_2_DISC PROJECT/CONTRACT DESCRIPTION 2
& o @] Electrical AEC_PROJ_3_DESCID PROJECT/CONTRACT DESCRIPTION /IDE...
o B Teler ammunicatinns T AEC_PROJ_4.ID PROJECT/CONTRACT IDENTIFIER IF NEED..,
= AEC_PROJ_STATUS %STATUSH
AEC_PROJ VOLUME VOLUME X
| EdtCustomPropetties.. | [ ok || cencel || Hep |
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TOC
Plotting

Only one PDF print driver is provided (AEC_pdf.pltcfg). This reflects the print CAD to PDF, print PDF to
hardcopy printer process. This workflow is used to ensure line weight thickness prints, across all print
devises consistently. Hardcopy’s where consistency does not matter is the exception. See Plotting

MicroStation
Baseline plot configuration files are delivered to show an example of how to set up plotting.

Note:

It is highly recommended that plot drivers be localized in an Extension to set optional settings in the plot
driver and the design script.

ProjectWise InterPlot (Iplot)

Baseline IPlot settings are also included to help set up IPlot.

A/E/C Users Guide June 2016 10
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Project Folders

The project folder structure remains mostly unchanged from the TS_WS_001 workspace version. This
should allow for a more seamless transition. This section of the documentation will review which items
go into each folder to offer a better understanding of how the Work Structure operates.

CAD_BIM

CAD_BIM is the parent folder that contains the sub folders for the design files. This folder is intended to
only contain the CAD/BIM/CIM files that are to be delivered to a contractor at contract award and the
supporting files needed to maintain those files.

_Master_Models

This folder is intended to contain all of the Revit Central Models or the Bentley Project Master Model
(the file that references each of the discipline Master Models into a single file for creating i-models or
other complete views of the project).

_Sheets

This folder contains all of the CAD files used as plotted sheet files for the project. This folder should only
contain the plotted files and not reference files. This allows for automated plotting procedures to plot
every file in the folder instead of having to maintain separate lists.

Cover sheet (located in the _sheets folder)

In accordance with the A/E/C Graphics Standards, the cover sheet is delivered. This will assist all
agencies in using a common standard cover sheet.

Discipline Folders

To help users identify the standard order for plot sets, the discipline folders are numbered in the order
the sheet are placed in the Plan set. The folder contains the 3D Desigh Models from MicroStation,
AutoCAD or the BIM/CIM software. The BIM/CIM software files contain attribute data the normal CAD
files do not have. These models are then used to create 2D Drawing Models.

Drawings

The Drawings sub-folder of each discipline folder is used to contain the 2D Drawing Models. 2D Drawing
Models are used to create annotative 2D drawing views by referencing the 3D Design Models to create
Details, Cross Sections, Plans, Profiles, Elevations and enlarged versions. 2D Drawing Models can also
contain typical 2D Details, schedules, photos, renderings, etc.

Note:
The project Border is located in the 01_Gen/Drawings folder.

Support (Project Datasets)

The Support folder contains both a Bentley Project Dataset and an Autodesk Project Dataset. The
Project Datasets are used by designers to add content to the project that isn’t added by the software or
Work Structure.

Note:
Extensions are used to add content by the CAD/BIM Manager to all projects.
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Design_Process
The Design_Process sub-folder structure is intended to be used by the designers to further organize to
their needs. This folder contains all of the design related documentation that is NOT intended to go to
the Contractor at contract award. The sub folders are organized by discipline and these folders will
contain design information such as Design Analyses, Calculations, Cut sheets, etc.

Note:
New folder creation under the discipline folders in Design_Process are up to the discretion of the users
needing them.

_Coordination
This is a folder to hold the various reports and reporting files for clash detection.

_Cut sheets
This is a folder to hold the data sheets of the equipment used in design.

_Design-Related Shop Drawings -AEC _WS-001_ProjectTemplate

e

This is a folder to hold Manufacturer supplied shop = ProjectData
drawings used in design. #-4-  CAD_EIM

" Design_Process
_Energy L _Coordination
This is a folder to hold energy calculations, support files B b Sheets

. I o _Design-Related Shop Drawings
for energy calculations, and LEED certification data. e
{7 _InRoads
_InRoads " Corridor Design (.ird)
This folder structure holds InRoads data files. It is located = Drainage (.sdb)
at the root of Design_Process for multiple disciplines to L' Geometry (.alg)
share these resources. This folder contains =" Projects (.rwk)
AEC_Horiz.xin. L’ Reports
L~ Surfaces (.dtm)

Discipline folders (=" Survey Data (.fwd)
The discipline folders hold the discipline specific data that o Template Library (.it])

is NOT sent to the contractor at contract award.

Out

The Out folder contains the sub-folders that receive the generated output from the CAD/BIM/CIM
processes.

IFC
This folder receives files generated by the IFC export process.

MISC
This catch-all folder is for receiving the files generated by processes other than IFC export and plotting.

PLOT

This folder receives the files generated from the print command. This is intended to be a temporary
holding place for files while they are checked, validated and sent to the printer/plotter for hardcopy
workflows or moved to the P&S Milestone folders.
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P&S Sets

This folder contains each of the Plans and Specification Sets for reviews and submittals. These are the
files that are ready for reproduction and/or the Record Sets for the project. The sub-folders should be
renamed to reflect the status of the content they contain (60%, 90%, Ready for Advertisement, Contract
Award, etc.).

Specifications
This folder contains the Specifications files. For Specsintact, this folder will hold the files once they are
complete and ready to be removed from the Specsintact project structure.

A/E/C Users Guide June 2016 13



This page intentionally left blank.

A/E/C Users Guide

June 2016

14



Recommended Workflows

This section describes the recommended method for designers to follow the A/E/C CAD and Graphics

Standards using the A/E/C Work Structure.

File Creation

The seed files, for Drawing and Design Model are located in the workspace standards seed folder (see
Seed Files for description). Horizontal is used for Horizontal construction (Site) models. Vertical is used
for Vertical construction (Building) models. The AEC_sheetSeed Model file is located in project dataset

TOC

seed folder (../CAD-BIM/Support/Bentley/Seed). All seed files have been predefined to have the
appropriate Units of Resolution, Master Units and Sub Units and have been cleaned of extraneous data.

The design team should verify all seed files are appropriate for the Project and ensure the sheet Seed
has the appropriate Project border attached and the correct data in the title block before starting any

new sheets.
Design Models

Design models are 3D models that can contain the information and
geometry of the design. Terrain models, structures, walls, ductwork,
piping, etc. are combined in these files to provide a base for creating
Views of Plans, Sections, Details and Profiles. The design models are
located in the CAD_BIM\(discipline) folders.

Drawing Models

Drawing models are the 2D representation of specific areas in the
design model to create the specific Plan, Section, Detail and/or
Profile to be references to the sheet Models. Saved Views and/or
Dynamic Views are created from the Design Model and are then
referenced to the Drawing model file at full scale using coincident
world. Most annotation, dimensions, notes with leaders, etc. should
be placed in the Drawing Models utilizing annotation scale. The
drawing models are located in the CAD_BIM\(discipline)\Drawings
folders.

Sheet Models

Sheet models are the plotted view representation of the Design and
Drawing Models and are located in the ../CAD_BIM/_sheets folder.
Sheet models have the Project border referenced to the sheet at full
scale using coincident world. The Project border is located in the
../CAD_BIM/01_Gen/Drawings folder. The same scale used for
annotation scale in the Drawing Models is used to reference the Plan,
Section, Detail and/or Profile to the sheet. Add titles, north arrows,
scales, general notes, legends, schedules, etc. to these files. Place
ONLY the files that are to be plotted in the _Sheets folder.
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File Naming

Design Model File Naming

The A/E/C CAD Standards does not fully define a BIM/CIM Design model file naming convention at this
time. Follow the A/E/C CAD Standards naming convention as closely as possible. The user defined fields
should be used to describe the model type.

Sheet & Drawing Model File Naming

For the automation to work correctly, follow the sheet and Drawing model Naming Convention in the
A/E/C CAD Standard. The _sheets folder should only include files to be plotted. Drawing Model Files go
in the discipline/Drawings folders.

A/E/C Standard Title Block and Border

The Title Block and Borders have been standardized and reconfigured to help with several issues. See
the A/E/C Graphics Standards for definitions.

1. The detail grid is made of smaller squares. The standard states, no more than one detail can
occupy the same grid block. The grid area on the old border was approximately 6” by 5-1/2”. For
example, a detail that was 6-1/8” by 5-3/4” would require four grids, which would be an area of
approximately 11 x 12 or 132 square inches. With the smaller grid, six grids are required, which
would be an area of 9 x 6 or 54 square inches. This leaves an additional 78 square inches to
locate additional Details and still be within the CAD Standards.

2. The title block revision area has been reconfigured to allow for consistency between Revit and
Bentley Projects. See the AEC Graphics guide for details.

Sheet Tltle BlOCk Tags Edit Tags [AEC_SHEET_DATA]
The sheet seed references the border and contains tag sets the user will Ar;nizEv_MARKE — i
need to edit. See the section on title block Integration below. oy opacy | DESCRPTON| e
AEC_REV_DESC3 —
AEC_REV_DESC4 =5
e Tags in the Title Block have the project data tag set shown in EcRev DEsce —————
orange and the sheet data tag set shown in green. See A/E/C CAD AL REV OESC/ _E
Stanfjards fgr full description'. To edit, Double Click, any Qreen .
text in the title block. The Edit Tags (AEC_SHEET_DATA) dialog will
appear, Scroll *<= to the appropriate field, Double click the ST —oe
field <= and enter the value, fill in any additional fields as
DRAWN BY: SOLICITATION NO.:
necessary and select .
_| CHECKED BY: CONTRACT NO.:

1. Inthe Management Block, lower right hand side, the two fields in

SUBMITTED BY:

orange are in the project data tag set for the optional titles of the

blocks and the two in green are in the sheet data tag set for the SIZE:

values. These fields may be used to record the number of the sheet

in the set, or to capture information such as the Signature, File Name, Facility Code, Drawing No.,
Drawing Code or some other Project/sheet specific information.

2. The Revision (Issue) Block contains the history of the revisions to the sheet. See the \ ;
A/E/C Graphics Standard for a complete description of usage.

3. The Building ID/Volume optional field allows for multiple buildings or Volumes to be
designed with the same folder structure. To allow for file separation in the folder
structure it is recommended this value be used in the user-definable project field of

SHEET ID

the file name.
4. A Status field was added below the lower right corner to reflect what stage the
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drawings are in. Optional values may include, Feasibility, Reconnaissance, Preliminary Engineering &
Design (PED), 35%, 65%, 95%, BCOE, Award, Modifications, Amendments, Engineering During

Construction (EDC), ... AS-Built.

5. The Production Data tags shown below, were added to the lower left corner of the border to allow
for capturing additional information during plotting. Additionally to allow for the binding of the plan
set, the lower left corner of the border and horizontal placement was chosen to place Production
Data optional fields. Optional values may include filename and path, date and time of plot, user
name, and discipline. These fields by default are modified by the plotting design script or pen table
text substitution but could also be used with title block integration and bound to an environment

variable.

Title Block Integration

If enabled by the ProjectWise Administrator,
many title block fields may use ProjectWise title
block integration. The tags are bound to
environment variables and when the files are
opened the tags are automatically updated.

To the right is an example of a ProjectWise
interface form for title block sheet data. On the
top part of the form are read only project
attributes that are written to the project folder
and then pushed to all files in the project
structure when opened. On the bottom of the
form the individual sheet title block data is
shown. Below is an example of title block
Integration from the form on the right.

al 133Hs

Sheet identifiers

ﬂEC_SheetSeed =~--. — o — \_

Components Spatial
More Aftributes File Properties Audit Trail

Workspace
General Security

AEC SHEET TITLE BLOCK DATA
District or Division: CONTRACT_NO

PROJ_DISTRICT CONTRACT NU ~
District or Division City, State Zip Code:  SOLICIT_NO

Attributes

Parent Organization:
ORG_NAME
District or Division Address:

ORG_DIST_OFFC ORG_LOC SOLICIT_NO

Project Title Line 1 Project Title Line 3 STATUS [
PROJ_TITLE_1 PROJ_TITLE_3 STATUS -

Project Title Line 2 TB Option 1 Title TB Option 2 Title
PROJ_TITLE_2 AEC_OPT1_TITLELPD ~ AEC_OPT2_TITLEPD ~

Update the Read Only Fields: PROJECT DATA

Sheet Title Line 1 SHEET DATA
SHEET_TITLE_1
Sheet Title Line 2 Sheet # # of Sheets TB Option 1 Value
SHEET_TITLE_2 0 0 AEC_OPTION1_ ~
Sheet Title Line 3: Project Title Line 4: TB Option 2 Value
SHEET_TITLE_3 PROJ_TITLE_4 v~  AEC_OPTIONZ. +
Designed By Design Organization Sheet ID No
DESIGN_BY »  CONTRACTOR_NAME - SH#
Drawn By Design Organization Parent. Drawing Code
DRAWN_BY v |CONTRACTOR_ID DRAWING_COL -
Checked By Design Organization Address: Issue Date: (Month Y
CHECKED_BY * |CONTRACTOR_ADDRESS ISSUE_DATE
Submitted By: Design Organization City, State Zip Code Building Type:
SUBMITTED_BY - CONTRACTOR_LOCATION BLDG_TYPE -
f
N
Close | k || < 217 > |12 ‘ I

U.S. ARMY CORPS OF ENGINEERS

DRAWN BY: SOLICITATION NO.:

CHECKED BY: CONTRACT NO.:

SUBMITTED BY:

The A/E/C Work Structure contains a Cell library (AEC_TitleBlock.cel) that has the title block data ready
to be placed in a sheet. These Cells have tags that can be controlled by ProjectWise title block
Integration. When setting up a sheet file from scratch, cells can be used to place the title block
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information in the Cell library AEC_TitleBlock.cel. See the A/E/C Standards for more information on what

information belongs in the title block.
TOC

Drawing Area Title Placement

The A/E/C Graphics Standards describes how the Drawing Area Titles are to be placed and annotated.
The A/E/C Work Structure contains a tool to assist in correctly placing them.

A Visual Basic Application (VBA) was written to automate the placement of the Drawing Area Title. The
“Place AEC Drawing Area Title” can be found on the General Task Menu. This tool provides two-point
placement and automated text for grid location. Options include:

TOGGLE TO USE THE REFERENCE
FILE DESCRIPTION INSTEAD
OF THE MODEL NAME

TOGGLE TO ADD A LINK TO THE SELECTED
REFERENCE FILE AND EACK/CROSS REFERENCE.

TOGGLE TO ADD BACK/CROSS REFERENCE
SYMBOL
(OPTIONAL USE)

MANUAL KEY OR AUTO POPULATES
TRUE NORTH BASED ON REFERENCE
FILE'S ROTATION

TOGGLE TO ADD THE WORD NOTE: AND FORMAT
TO BE PLACED ABOVE THE DRAWING AREA TITLE.
IT MOVES UP AS ADDITIONAL NOTES ARE ADDED

TOGGLE TO PLACE THE
PLAN NORTH SYMBOL

/7 TOGGLE TO PLACE THE

TRUE NORTH SYMBOL

pm{ AEC Drawjng Area Title / [
1 i -y
W Add Link P ] |_P|a1North; N
o o S True North
W Use Cross Referendng |~ Use Reference Description instead of Model Name o

CROSS REFERENCE
GRID LOCATION —

Ird
Angle:
~~./”\ [ROTATED DETAIL |

== A1

CROSS REFERENCE P SCALE: 1" =1
SHEET NUMBER ~ — /Ir N
SCALE: AUTOMATICALLY SET TO THE /
SELECTED REFEREMCE FILE'S SCALE BAR SCALE OFF/ON TOGGLE
TOGGLE SETS SCALE PULL DOWN MENU TO SELECT TITLE BASED ON
TO NTS (NOT TO SCALE) REFERENCE FILE DESCRIPTION OR MODEL MAME
BACK/CROSS REFERENCE LINK PLACE AUTO LINK TO SELECTED REFERENCE
HOLDER IS DENOTED BY A PLUS (+) SIGN FILE CREATED BY ADD LINK TOGGLE
NOTE: AUTO TRUE NORTH ANGLE BASED
1) PLACED USING THE DETAIL NOTES TOGGLE OM REFERENCE FILE'S ROTATION
2) SCALES ARE NOT OPTIONAL. YOU MUST HAVE
EITHER A DESCRIPTIVE SCALE, OR A BAR INSERTION POINT FOR
SCALE OR BOTH TRUE NORTH ARROW

3) FOR THE DESCRIPTIVE SCALE OF NTS USE
THE OVERRIDE SCALE TOGGLE

INSERTION POINT FOR PLAN

x-gﬁ@ 59I1AT E D D ETAl L | NORTH SYMBOL ANOD BAR;CALE N

\

s BACK/CROSS REFERENCING SYMBOL

AUTOMATIC SCALE BASED ON REFERENCE FILE SCALE

SHEET # AND GRID LOCATION OF AUTOMATIC GRID LOCATION. MANUAL PLACEMENT

DETAIL CALLOUT REQUIRES THE X# IN CELL TO BE REPLACE WITH
THE GRID LOCATION FOR THE DRAWING AREA
INSERTION POINT FOR DRAWING AREA TITLE TITLE SYMBOL E.G. (F2)

NOTE AND CROSS/BACK REFERENCING SYMBOL

Note:

When using the VBA tool for placement of the Drawing Area Title, the standard border with the 3” grid
has to be referenced at 0, 0 with a scale of 1. The referenced model name has to be named
appropriately. The referenced model has to be scaled according to the standard annotation scale factors
and rotated if necessary. If any of those items are not in place, further editing will be necessary. See
below for a graphical view of how the Drawing Area Title is placed on the grid.
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VBA uses the same Workspace Cells that can be used for manual placement. These Cells contain
tags/attributes and are designed to be placed at the grid intersections. The Cells are designed to take in
to account the placement for 2 to 13 grids. These Cells are located in the AEC_Div01 - General
Requirements cell library.

Project Explorer
To quickly place these Cells open the Project Explorer (File -> % Lnks 58 e
Project Explorer) dialog tab, Select Links -> AEC_Common

[$)
"= AEC_Common

Under (Cells -> Titles and Scales) Double click a Drawing Area Title G0 Project Data
cell based on the number of grids use in the Detail, and pick the : L';;'r:

intersection of the sheet grid, to place the Cell. Double click the text
to edit the tags. Select the Plan north, and scale as necessary and
place according to the graphical Drawing Area Title view above.

4 PDF Cell List
4 AEC Cells
- Titles and Scales

L. 014200-001 Drawing Area Title - 02 Grids
P 014200002 Drawing Area Title - 03 Grids
¢ 014200-003 Drawing Area Title - 04 Grids
< 014200004 Dlawing Area T'rtle -05 Grids

& 014200-005 Drawing Area Tile - 06 Grids|
The following convention is an accepted practice and will be 47 014200-006 Drawing Are Title - 07 Grids

incorporated into future revisions of the A/E/C Graphics Standards.

Back References

Best Practice Note: If the drawing area is referenced multiple times (not recommended), the first
reference listed relates to the first sheet listed, second relates to the second, etc.

/~ THIS POINTS TO THE GRID LOCATION
WHERE THE SECTION/DETAIL INDICATOR
IS FOUND ON THE SHEET

DRAWING AREA TITLE

SCALE:

CROSS/BACK
REFERENCE CELL

|
|
|
|
|
|
|
1\ X#
INSERTION POINT — | X- #ﬁ#

The following convention is an accepted practice and will be incorporated into future revisions of the
A/E/C Graphics Standards.

Detail Notes

Best Practice Note: place an extra line feed or two after the notes to move them up.

|
|
1
= DETAIL NOTE CELL
NOTE: “*

- DRAWING AREA TITLE

|
|
|
|
|
\
\
\
|
|
|
INSERTION POINT — |
\
|
\
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References

All references should be located within the Project CAD_BIM folder structure. Cross References to files
in other projects is not acceptable. The recommended workflow for project delivery is to copy the
CAD_BIM folder, in its entirety, and send it to the recipient. Therefore, it is important for designers to
keep unnecessary files out of the CAD_BIM folder. Designers are responsible for this content and should
periodically clean the files of all unnecessary references and verify that all necessary references are
located inside the project.

Attachment Settings

Reference file paths

The A/E/C Work Structure has been set to disallow the use of full file paths. When full file paths are
used, projects become less portable. It is better to use the MS_RFDIR variable to set the search path for
references or use relative paths.

Tools  Settings
i > G by N - —_—
B g DG R A8 g D 2T @) X e Mode: [Boundares ~
Hierarchy File Name Model Description Logical Crientation Presentation [] .J X%
=+ Prawing Area Tile Demo dan. ANSI O . \AEC_TileBlock_AN... Border ANSI D Border and Title B... _AEC ANSI D Border Coincident ~ Wireframe v v+
_AMAEC TitleBlock_ANSI_D.dgn Drawing Area Title Demo.dan SMALL DETAIL Standard Top View PLAN OF SMALL DETAIL  Standard Top  Wirsframe: A
PLAN OF SMALL DETAIL, Drawing.. Drawing Area Tile Demo.dan SIGN DETAIL Standard Top View FULL SIZE DETAIL Standard Top ~ Wireframe VY

Model, Description & Logical Names

When attaching a reference filg, it is the responsibility of the designer to fully define the purpose of the
reference attachment. The Model Name of the file attached, reference file Logical Name, which is a
requirement of the A/E/C CAD Standard and the Description field should be used as necessary to fully
define the purpose of reference attachments. These fields give users a description of the purpose the
reference and it also is used for conversions between different software.
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Ignore When Live Nesting

When referencing a file, it is important to decide how you want the file to perpetuate itself
E to others who may be referencing your files. “Ignore When Live Nesting” works in

conjunction with “Live Nesting” or “Copy Attachments” in the Reference dialog box. “No
Nesting” treats every nested reference as ignored, whether it is set to “Ignore When Live
Nesting” or not.

There are two choices:

ON, is when you DON’T want others to see your reference when they turn live nesting on. This is the
same as an AutoCAD XREF Overlay.

Example: An Architectural designer, when assembling their model, would reference the structural
columns to know where to place the walls, but since they don’t control the columns they turn ON
“Ignore When Live Nesting”. Others wanting to reference the walls would not be able to see the
columns when Live Nesting is turned on. If they want the columns included, they would have to
reference the columns directly.

OFF, is when you DO want other users to see your reference when they turn live nesting on. This is the
same as an AutoCAD XREF Attachment.

Example: A designer, when creating a drawing model (to later be referenced to a sheet), would
reference the floor plan to be able to dimension and place notes. Since they need the floor plan to show
up on the sheet, they would turn OFF “Ignore When Live Nesting”. The floor plan would show up on the
sheet as a nested reference.

Note:

It is very important to make sure “Ignore When Live Nesting” is turned ON for every reference that isn’t
absolutely needed for the file. ProjectWise will copy out files that are attached and not displayed, so
designers should be conscious about what files are referenced and how they are referenced to speed up
file opening times. Files outside ProjectWise, will pull more than is needed when using packager to pull
files to send to others if “Ignore When Live Nesting” is OFF when it would be better set as ON. Files
being converted to DWG will have the Xref setting set to Overlay when the option is set ON and set to
Attached when set to OFF (Overlay is the preferred option for most AutoCAD Xrefs).
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Raster References

File names shall conform to the model file naming convention in the A/E/C CAD Standard with a model
file type of “IG” (e.g. *C-IGXXXX.tif/jpg).

Raster files referenced to sheets or models shall be placed in the respective discipline drawings folder.
Images not referenced to the CAD_BIM files shall be place in the Design_Process discipline folder. Folder
creation in Design_Process is up to the discretion of the users needing them.

Raster File Types

TIFF:
The GeoReferenced TIF file format is the preferred option for aerial photographic imagery,
maps, and drawings where the image is referenced under line work to add more clarity.

MrSID:
It is NOT recommended to keep MrSID files directly referenced to the production set. The files
are extremely large and difficult to manage in a CAD/BIM/CIM environment. It is recommended
that the MrSID image be clipped, resampled, and saved as a GeoReferenced TIF file. The smaller
file size will allow the software to open faster, plot more effectively and be converted to DWG
file format easily if needed.

JPG:
The JPG file format is the preferred option for non-aerial photographic imagery used for
depicting existing conditions referenced to sheets.

PDF and other raster formats:
The use of other formats is not recommended. Other raster files and PDF files used as
background images shall be renamed as above and can be used as raster references.

Note:

Although the CAD Standard recommends that PDF files be used as raster references for scanned

drawings, the TIFF file format is better suited for converting to a DWG file format.

Binding

Per the A/E/C CAD Standard, binding references (i.e. importing reference files into the file or merging
references) is not allowed. Merging references makes future editing extremely difficult and dramatically
increases file size. It is better to use due diligence to verify that references are delivered with the parent
file.
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Schedules/Excel Spreadsheet, Sheet Index

TOC

In accordance with the A/E/C Graphics Standards, the proper settings in Excel for use on CAD sheets are

the following:

Note:

Although the text is not exactly 3/32” high, this process approximates the A/E/C Graphics Standards,

without overcomplicating the process, to what has been determined to be acceptable.

1. All Text is Arial font.

AL -

u

Home Insert Page Layout Far

$ ~ |12 - AN
Paste o || B 2 U -] A
Clipboard M Font F]

a.

b. Sub Titles and all other text is Font Size 10.

Main Titles are set to Font Size 19.

2. To combine cells for Titles:

a0 oo

e.

Highlight all cells to be combined
Right click on them

Select Format cells...

Select the Alignment tab

Format Cells
Number | t| Font | Border Fil I Pi
Text alignment
Horizontal:
Center E Indent:
vertical: 0 =
Center E

Justify distributed
Text control
[ wrap text
[ shrink to fit
Merge cells
Right-to-eft
Text direction:

Context E

Turn on Merge cells
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3. Center text appropriately
L e
Faormulas Data Review

NI

(F Alignment (F

4. Line work around each cell is “All Borders”.

Right Border

i | Mo Border
E Al Borders
[F] Outside Borders
[ 1hick Box Border

5. A “Thick Box Border” surrounds the entire schedule and the sub titles.

All Borders
Outside Borders
Thick Box Border

£t
| E
=

Bottom Double Border

- . . —rE
— Home Insert Page Layout Formulas Data Review View Developer Add-Ins Acrobat ProjectWise @ - 7 X
= * . e =]__ = ,EConditionalFormatting' j"’Inser‘l:v E -

Arial (10 - |[SA = = =||¥ = General =
_j EE] | | | | . @Format as Table = j““ Delete ~ E'

Past = = SA-E== = o = <0 .00 o Sort & Find &
e 54 /B 7 u-|0 ”&. A-||E=E= 5| &= |$. % o ||%8 %) (5} Cell Styles - & Format - | 2+ ,:i?te,. SLTm.
Clipboa... ™ Font (F Alignment Fi Mumber (F Styles Cells Editing |

M5 - fe | v
A B c D E F G H 1 J K L
1 MAIN TITLE
2 SUB TITLE 1 SUB TITLE 2 SUB TITLE 3 SUB TITLE 4
3 DATA 1 DATA 2 DATA 3 DATA 4 =
4 DATA1 DATA 2 DATA 3 DATA 4
5] | DATA1 DATA 2 DATA 3 DATA 4
6 DATA1 DATA 2 DATA 3 DATA 4
7 DATA1 DATA 2 DATA 3 DATA 4
8 DATA1 DATA 2 DATA 3 DATA 4
9 DATA 1 DATA 2 DATA 3 DATA 4
10
11
M 4 b W] Sheetl  Sheet2 ~Sheet3 %1 0| m i
Ready | & | | E=Y] o——0 T

To place the schedule in MicroStation.
6. In Excel, highlight the shedule, right click on it, and copy it.

7. In Microstation, pull down Edit and select Paste Special.
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8. Pick “Embedded Microsoft Office Excel Worksheet” and Paste

Paste Specal

Picture of Microsoft Office Bxcel Wor...
Embedded Microsoft Office Bucel Wo ..
Linked Microsoft Office Excel Worshest |=
Text To Design File
Rich Teat to Design File
Linked Text Ta Design File o

| »

n

Paste ] [ Cancel ]

L

9. Change the Method to “By Size”, Turn on “Transparent Background”, and set the scale to “1”.

@ Paste OLE Object (8 -3

Object: Microsoft Office Bxcel Wornishest
Paste as} [Embedded = |

Method:

[] Display as icon
Transparert Background
Rotate With View
Scale: | 1.0000
Size: (4.510=1.781)"

L

10. Select an appropriate location for the schedule.

Note:
Updating the schedule may require repeating the process.
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Creating a sheet Index in ProjectWise

See AECWS YouTube video Playlist Sheet Index
https://www.youtube.com/playlist?list=PL_dyQNgimJWwQSHqUBKfWMcAtBx2I0-d7

Go to and open with Excel, the AEC_INDEX_ TEMPLATE.xIsx located in the project folder

NOTE: The AEC_INDEX_TEMPLATE.xIsx file is delivered in the .\CAD_BIM\01_Gen\Drawings\ of

the

template Project folder in WSC_001 Update 4 and can be copied and used on existing projects.

1. In ProjectWise, go to the Sheets folder in the project you are creating an index for.
2. Select view named “Sheet Index” or you may create one with the columns, Sheet ID, Sheet Title

1, Sheet Title 2, Sheet Title 3 and File name. See YouTube video.

3. Highlight the sheet files you wish to create an Index Schedule from (Ctrl A, will select all files)

B ProjectWise Explorer Vi (SELECTseries 4)
Datasource Folder Document USACE PCM vBi

Export View Tools Window Help

[E=B(ECR =3

] : Interface|_nwk_z Pwis

W Sheet t
Z.FPC

«

©Co~NoO

For Help, press F1

L116_BNL-IN507.dgn
L116_BNL-IN601.dgn
L116_BNL-IN603.dgn
L116_BNL-IN711.dgn
L116_BNL-IN712.dgn
L116_BNL-IN730.dgn
L116_BNL-IN801.dgn
L116_BNL-IN802.dgn
L116_BNL-IN811.dgn
L116_BNL-IN812.dgn
L116_BNL-LS100.dgn
L116_BNL-L5201.dgn
L116_BNL-M-001.dgn
L116_BNL-M-110.dgn

}:

z.
SHEET_TIT ZPW Lookup Name

m

=y 220 2y @ @ - searen 0 ~ > view[sheetinaex
4 - & - | [ G address [od p uments\Research and D e operties
e CAD_BIM + | B Ut | @ Spatial]
LD Master Models | o et peF MO SHEET_TITLEL SHEET_TITLE.2 Help Desk
:t aihéj: /@msm INTERIOR DETAILS
507 02 HazMat /Einsor INTERIOR ROOM FINISH SCHEDULE
o 03 SunMap Zine0: INTERIOR FINISH MATERIALS LEGEND
i [0 04_Geotech _/IN711 FIRST FLOOR FLOORING PATTERNS
e[ 05_Civil /ﬁINTlZ FIRST FLOOR FLOORING PATTERNS
o 06 Lndscp |2 | LEBINT30 FLOORING PATTERN DETALS
-7 07 Struc Zifmso1 INTERIOR SIGNAGE DETALLS
- 08_Arch /i Nz02 INTERIOR SIGNAGE SCHEDULE
- 09 Int S TBme1L SIGNAGE FIRST FLOOR PLAN
{0 11 FireProt STz SIGNAGE FIRST FLOOR PLAN
-2 12 Plumb A 00  OVERALL SITE PLANTING PLAN
-7 14 Mech ZE1s201  ENLARGED PLANTING PLAN
2 15 Elec Aham-001 MECHANICAL, HVAC, PLUMBING & PIPING LEGEND
&£ 16 Telcom ZE@M10 FIRST FLOOR MECHANICAL PLAN
-7 17 Resource Ziaman PARTIAL FIRST FLOOR MECHANICAL PLAN
= if:::’n" . | ZE@man2 PARTIAL FIRST FLOOR MECHANICAL PLAN
B m » 4 Ulf

L116_BNL-M-111.dgn
L116 BNL-M-112.dgn =
3

6:28 AM

4. Right-Click, anywhere in the highlighted section, at 1/4 Copy List To i Clipboard Tab Separated
the of the way up from the bottom Select Copy List To Attributes » Clipboard Space Separated
> Clipboard Tab Separated ! Change State 4 e~
Select the InputValues tab at the bottom left,
Select the cell Al highlighted in yellow, Right click and select Paste
Remove any rows for files that do not belong in the index
Scroll to the bottom and identify how many rows you have
In SortedSheets tab, Highlight row 1 A-D
A B C D
1 [SHEET REF N{SHEET TITLE 1 SHEET TITLE 2 SHEET TITLE 3 FILE NAME 7.05]<— C

2

=]
>

10. Hover your cursor over the dot at the lower right hand of rowl — column D

11. Right press and hold to drag the data box the same number of rows you identified in step 7
NOTE: In column D of the image below, you see “Incorrect Sheet ID” for some of the rows. The
AEC_WS_Sheet_Indexer.xIsx follows Table 2-3. Sheet File Discipline Designators of the A/E/C

CAD Standards 6.0 any deviation must be dealt with manually

140
141
142
143
144
145
146
147
148
149
150
151

P-303

P-304

SE001
SE002
SE110
SE200
SE210
SE211
SE310
SE3N
SE321
SE322
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PLUMBING ISOMETRIC NATURAL GAS PIPING

GENERAL STRUCTURAL NOTES

GENERAL STRUCTURAL NOTES

FOUNDATION PLAN

PARTIAL FRAMING PLANS

ICF CONCRETE SHEAR WALL ELEVATIONS (INCLUDING ATFP)
ICF CONCRETE SHEAR WALL ELEVATIONS (INCLUDING ATFP)
FOUNDATION SECTIONS

FOUNDATION SECTIONS

FLOOR FRAMING SECTIONS

FLOOR FRAMING SECTIONS

June 2016

L116_BNL-P-903.DGN

L116_BNL-P-304.DGN

L116_BNL-SE001.DGN Incorrect Sheet 1D
L116_BNL-SE002. DGN Incorrect Sheet 1D
L116_BMNL-SE110.DGN Incorrect Sheet ID
L116_BNL-SE200.DGN Incorrect Sheet ID
L116_BNL-SE210.DGN Incorrect Sheet ID
L116_BNL-SE211.DGN Incorrect Sheet 1D
L116_BMNL-SE310.DGN Incorrect Sheet ID
L116_BMNL-SE311.DGN Incorrect Sheet ID
L116_BNL-SE321.DGN Incorrect Sheet ID
L116_BNL-S5E322 DGN Incorrect Sheet 1D
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https://www.youtube.com/playlist?list=PL_dyQNgimJWwQSHgUBKfWMcAtBx2l0-d7

12. Ensure from cell Al, columns A, B, C and D to the end of the

data are still highlighted, Select the Sort & Filter > Custom Sort

;'Z‘Y H

A predefined custom sort is displayed, Select My Data has Headers

Sort =5
l 4| Add Level H < Delete Level “ [ Copy Level J E“ Options... J My data has headers
Column Sort On Order
Sortby Incorrect Sheet ID Iz‘ values E‘ Smallest to Largest Iz‘
Thenby 'SHEET REFNO  [+] |Values [=] [atoz [+]
Co ) [ o

—

¥ [Sort & Find &
Filter = Select -

iti 8] SortAtoZ
Zl sotZtoA

Custom Sort..

In this example, Custom Sort will sort by Column D “Incorrect Sheet ID” 1%t then by Column A
“SHEET_REF_NO”

NOTE: The header name for Column A may differ depending on the variable used for Sheet ID in
your ProjectWise implementation.

13. Select OK

14. Starting from cell A2, highlight all the values in columns A, B, and C to the end of the data,

15. Right press and select Copy

16. Select the Index tab

17. Select the cell A4 highlighted in yellow, Right click and select Paste > Values

NOTE: you must Paste Values or you will not get the sorted data.

18. Insert 2 rows between each Discipline,
19. Go to the bottom of the data and check how many rows you have.

NOTE: An ANSI D-Size sheet, depending on the length of the description, can accommodate
approximately 3 to 4, three column groups of 110 rows.

20. Cut the overflow data based on 110 row maximum, Select cell E4 highlighted in yellow, Right-
Click and paste Repeat as necessary in cell 14
21. Go to the top of the sheet, Cells A3-C3 are merged to create the Discipline Heading field

22. Select the cell A3-C3, Right-Click > Copy (Crtl-C) the Discipline Heading field

23. Select first cell on the far left above each discipline, Column A, E or | Right-Click > Paste (Crtl-C)

NOTE: The Discipline name will change automatically depending on the first character of the next

line.

24. Select entire table and change the Highlight color, background to white

25. Add any additional formatting

26. Highlight the entire Index table and Copy (Crtl-C)

27. Open the Sheet file and paste special, embedded

28. Change to place By Size with Scale = 1

29. Tentative to lower left of titleblock area and hit "0",

30. Tentative to upper right and hit "/2", and a data
point to center the index on the sheet.
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Paste Options:
ey o . Y - ke
D & &% e
» S
Values(V)
H A === &-
Theme Colors u
dlh (T
7 m
White, Background 1
| C
ST
Paste Special [ PasteOLEObject | = | = [[3]
Object: Microsoft Excel Worksheet
Data Type

Ficture of Microsoft Excel Worksheet
Embedded Microsoft Excel Worksheet
Linked Microsoft Excel Worksheet
Text To Design File

Rich Text to Design File

Linked Text To Design File

m

[ Paste ] l Cancel

Paste as: |Embedded  ~
Method: | By Size hd

[ Display as icon
[ Transparent Background
Rotate With View
Scale: | 1.0000
Size: (21.302x 15.740) "

-
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Symbology

Annotation & Drawing Scales

TOC

All of the cells, text, dimension, and line styles in the A/E/C Work Structure are designed to work with

=]

e S

-

Text Style: [ AEC_COMN Te v | Q 2y

)|

v

Annotation & Drawing Scales. -
':,l_} Place Text
{4 Place Active Cell SR —
i Gl | ] 1 :

Active Angle: | 0.0000° = Active Angle: | 0.0000
¥ Scale: | 1.000000 —| Height: | 0:0.0938 [ 2
Y Scale: | 1.000000 — | Width: | 0:0.0938 | .
Z Scale: | 1.000000 L ' Apply changes to all text I

-

The Drawing Scale dialog is activated from pull down

Seftings | Tools Ltilities W o
menu (Settings -> Drawing Scale). This menu allows the [ Tool Settings Drawing Scale ﬁ
user to quickly adjust the Annotation scale. It is NOT :_j AccuDraw fFeat =
recommended for users to change the working units. Color Books. . linches =
The Annotation scale lock must be enabled to use Color Table... .
Annotation scale. Make sure the Auxiliary Coordinate Database v {Full Size 1-1 )
System (ACS) is set to the same settings as the _ Q?S‘Q“ File CUSTOM ACS -
Annotation Scale or turn it off. Changes should only be '|‘5J g:zpl—._ﬂsgels | & Full Size 1=1 -
made if the project workflow dictates. = I |k
Delivered Scales include:
Name Scale Name Scale Name Scale
Full Size 1=1 1:1 1"=40' 480:1 1:2.5 2.5:1
6"=1'-0 2:1 1"=50"' 600:1 1.5 5:1
3"=1'-0" 4:1 1"=60"' 720:1 1:10 10:1
11/2"=1'-0" 8:1 1"=80" 960:1 1:20 20:1
1"=1'-0" 12:1 1"=100' 1200:1 1:25 25:1
3/4"=1'-0" 16:1 1"=200' 2400:1 1:50 50:1
1/2"=1'-0" 24:1 1"=300' 3600:1 1:100 100:1
3/8"=1'-0" 32:1 1"=400' 4800:1 1:200 200:1
1/4"=1'-0" 48:1 1"=500' 6000:1 1:250 250:1
3/16"=1'-0" 64:1 1"=600' 7200:1 1:400 400:1
1/8"=1'-0" 96:1 1"=800' 9600:1 1:500 500:1
3/32"=1'-0" 128:1 1"=1000' 12000:1 1:1000 1000:1
1/16"=1'-0" 192:1 1"=2000' 24000:1 1:5000 5000:1
3/64"=1'-0" 265:1 1"=3000' 36000:1 1:10,000 10000:1
1"=5' 60:1 1"=4000' 48000:1 1:25,000 25000:1
1"=10' 120:1 1"=5000' 60000:1 1:50,000 50000:1
1"=15' 180:1 1"=6000' 72000:1 1:100,000 100000:1
1"=20' 240:1 1"=8000' 96000:1 1:250,000 250000:1
1"=30' 360:1 1"=10000’ 120000:1
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Annotation Styles
The A/E/C Work Structure contains several text styles:

AEC_COMN_Text - Most text is this style. 3/32” Arial font.
AEC_COMN_Text_MASK - Same as above with masking turned on.
AEC_COMN_Title - Used for Titles. 3/16” Arial font.
AEC_COMN_Title_MASK - Same as above with masking turned on.

Additionally, several more HORZ_ styles are added, via the Horizontal
dataset, for use with InRoads or GeoPAC to set specific justification. These
styles are only loaded with Horizontal tools such as InRoads or GeoPAC
and begin with “AEC_HORIZ_...".

TOC

&% AEC_COMN_Text

2 AEC_COMN_Text_MASK

2 AEC_COMN_Title

2 AEC_COMN_Title_MASK

2 AEC_HORIZ_Text_CC

2 AEC_HORIZ_Tet_CC_MASK
2 AEC_HORIZ Text_CT

2 AEC_HORIZ_Tet_CT_MASK
%2 AEC_HORIZ_Text_RT

%2 AEC_HORIZ_Text_RT_MASK
2 AEC_HORIZ_Title_CC

%2 AEC_HORIZ_Title_CC_MASK
%3 AEC_HORIZ_Tile_CT

3 AEC_HORIZ_Title_CT_MASK
%3 AEC_HORIZ_Title_RT

%3 AEC_HORIZ_Ttle_RT_MASK

The horizontal styles are intended for use by the automatic text placement tools within InRoads, and

should not be used for text that is manually placed.

On some drawings, a user may want the text to be masked. To make the
process of changing the style easier, a tool has been placed in the Right
Press menu to toggle text between the AEC_COMN_Text and the
AEC_COMN_Text_MASK text styles.

Right Press, select Toggle Text Mask, left click to select the text, then right
click to apply the toggle. Right click again to end the process.

Before: After:

=

The A/E/C Work Structure contains several dimension styles:

Name - Used for:

AEC_MS_Horizontal-Arrow
AEC_MS_Horizontal-Slash
AEC_MS_Vertical-Arrow
AEC_MS_Vertical-Slash
AEC_MS_Notes
AEC_MS_Keynotes
AEC_MS_Callouts

- Arrowhead with 1.23’ style text.

- Slash style with 1.23’ style text.

- Arrowhead with 1’-2" style text.

- Slash style with 1’-2” style text.

- Notes with leader.

- Notes with leader and diamond shape.

A/E/C Users Guide June 2016

Recent InRoads File

[ Survey Details
Tum Off InRoads Annotation

Wiew Control

Toggle Text Mask

i

Bxplorer Show/Hide
InRoads

Copy
Move
Scale
Rotate

Mirmor

o 2 [ 5 g

- Keyed notes with or without a leader and circle shape.



The most common tools are found under the General Tasks:

Place Text: Places you on the G-ANNO-TEXT level, set the
AEC_COMN_TEXT style current, and starts the place text command.

Place Note: Places you on the G-ANNO-TEXT level, set the
AEC_COMN_TEXT style current, sets the AEC_MS_Notes dimension style
current, and starts the place note command.

Place KeyNote: Places you on the G-ANNO-KEYN level, set the
AEC_COMN_TEXT style current, sets the AEC_MS_Keynotes dimension
style current, and starts the place note command.

Place Arch Dimension: Places you on the G-ANNO-DIMS level, sets the
AEC_MS_Vertical-Slash dimension style current, and starts the place
dimension command.

Place Civil Dimension: Places you on the G-ANNO-DIMS level, sets the
AEC_MS_Horizontal-Slash dimension style current, and starts the place
dimension command.

Line Styles

This folder contains the Line Style Resources. The Line Styles have all been
completely redefined and renamed. The Line Styles all rescale with
annotation scale properly and no longer need an adjustment for UOR as
long as the AEC_WS_001 seed files are used (See Seed Files for
description). The style names now reflect both the MasterFormat division
structure and an expanded description to give a better indication of what
it is used for. The Key-in “LC=" can be used to build an on-the-fly line style
dialog box to easily locate the Line Style you are looking for. The example
on the right is the result of “LC=Water”. For a complete listing of the
delivered Line Style see AEC_WS_001_Symbols_Guide.pdf in the
AEC_WS_001/Docs folder.

Line widths

Tasks

- 1X

[_—1 Tasks

B ROV R R P S

“ Civil Tools

\2 Civil

A General

L

> |k

[~ @ Piace Civil D A

Place Text

1 Wl Place Plan Callout
- E|Schedules
‘\f R | X-Y coordinate grid lines

[ T T N

AF T Rediines

@ Subsurface Utility Enginee

Place Note
Place KeyNote
Place Arch Dimension

Place Civil Dimension

Open "Annotation’ as Toolbox

\2 Drawing

ﬁ Power InRoads Commands
z "

&/ Solids Modeling

» surface Modeling

& Terrain Model

@ Feature Modeling

ig Visualization

B aAnimation

-
-
-
v
v
v
v
v

-

Select Line Style

221100-901 Domestic...
221100-302 Water - Dr...
221100-303 Water - Dr...
221100-504 Domestic...

221100-505 Domestic Water - Hot - Supph.'t

221100-306 Water - 5...
221300-303 Gray Water
224500-301 Water - T...
224500-302 Water - T...
226700-301 Water-D...
226700-302 Water - Di...
232100-307 Hot Water...

-

o)

[ Cancel J

The A/E/C Work Structure has many items preconfigured to establish the line widths. The plot driver in
.\Standards\pltcfg\ has been set to plot the line widths in Table 3-1 of the A/E/C CAD Standard.

]

AEC_pdf - Printer Driver Configuration

File
| Base Properties | Paper Sizes | Color Maps | Weight Maps | Line Styles I Fort Maps | Programs | 5 [

Define maps from design weight to print width

Print Width i
0.18 mm
0.25mm
0.35mm
0.5mm

0.6 mm

0.7 mm |

Design Weight

m

[ R
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The conversion to and from DWG settings are set to also utilize those line weights.

-
Save As DWG/DXF Options
General | Remap " References " Filter |
Name Value e
Basic
Advanced |
Feferences
DGN Weight DWG Weight (Milimeters)
0 0.18
1 013
2 0.30
3 040
4 0.53
5 0.70
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Level colors

The colors set in the Levels are set to standard RGB field colors used by industry. They should be
acceptable for most work. All work should be placed using the bylevel setting. To screen objects in
reference files, the Levels bylevel color setting can be changed to one of the screened colors listed in
Table 3-3 of the A/E/C CAD Standards. The color tables in the workspace have been set to reflect the
screened colors of the A/E/C CAD Standard. The plot drivers and design script files have been set to plot
the screened color numbers as screened and all others as black. The bylevel setting allows for easier
translations to DWG.
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Printing and Plotting

Print Styles

TOC

With this release of the workspace we have created a Print Style for each of the 5 different paper sizes

(ANSI A,B,D,E and F). Below are the default settings for the Print Styles the only difference between

them is the paper size.

Print Area: Sheet

View: 1

Paper: ANSI (varies on sheet border used)
Orientation: Landscape

Units: in

Size and Scale: Maximize
Resymbolization: Design Script (AEC_Screen.dscript)
Color: Grayscale

Rasterized: OFF

Print3D: OFF

Print raster images: ON

Update from Design File: ON

Printer driver: AEC_pdf.pltcfg

Screening and Gray Scale

Screening and Gray Scaling is a process that lets the user de-emphasize plotted graphics. The user
achieves this by assigning a predefined Gray Scale colors to the graphics they wishes to be de-

emphasize.

By Logical Name (Reference file — whole)

Sample Logical Name

SCRN60 | Topo — Scrn60

SCRN50 | Topo —Scrn50

SCRN40 | Topo — Scrn40

SCRN30 | Topo —Scrn30

SCRN20 | Topo —Scrn20

By Color (Reference file or Active File)

Use level manager to set by-level color to a gray scale value

A/E/C Users Guide June 2016
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TOC
Work Structure updates

On occasion, you may be asked by your CAD or ProjectWise Manager to purge the workspace from your
local machine. This is due to the release of updates to the workspace and the need to clear old files from
each machine so they will not conflict with the updates to the A/E/C Work Structure. To purge the
workspace files from your computer:

1. Open ProjectWise and log in to the datasource to be purged. If you are already in ProjectWise,
close all open files from ProjectWise.

2. Open the Local Document Organizer.

W W —e—
&P ProjectWise Explorar VBi (SELECTseriesan-H‘ A

Datasource Folder Document USACEPCMvBi  Export View Tools Window Help

- - ELo.caI Docurn:lﬂ Organizer P-ed-pwint.nwk.ds.usace.army.mil:PWNWKOD\Docur

Bl = | I Ty N R

3. Select Workspace Copies.

Dlganizer View Action

vIALM S8 F

4. Select all of the files located here. (Ctrl + A will select all)

Folder: [I] ||
Mame Description Type File Mame =
— Bar ] . . e
m.‘ u| y = l
D 2 I
5. Select Purge Copy. (or right click on the files and select Purge Copy)
——— Local Document Organizer - Workspace Copies l‘ < Elﬂu

QOrganizer View

vEAEm I8 & | v PG &
Filters ; [:Purge(:opy

The next time a file is opened, the new workspace files will be downloaded to your computer.
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i-models

i-models are the conglomeration of the 3D objects and the facility data present in BIM models. i-models
can be used to share data with others who don’t necessarily have any design experience.

The i-models generated from both Bentley AECOsim Building Designer and Autodesk Revit contains a
wealth of information that wouldn’t necessarily be accessible to lay persons without the design software
that created it.

Two visualization tools, Bentley Navigator or Bentley View, can view the i-model and allow the user to
guery the data within. Additionally, Bentley software can reference the i-model as any other model and
the data becomes useful to them (e.g. A Civil engineer could reference an i-model created from Revit
and use the data and location to to allow to connect the utilities to the building design).

Creating i-models

Although the uses for i-models may be varied, the creation process is the same. See the i-modellmporter
documentation found in the Extensions folder for the steps on how to create an i-model.

Quantity Take Off

The i-modellmporter extension (included in the Extensions folder) contains a tool to help users
view/import the i-model data into Microsoft Excel to view the model data in a tabular form. This tool
also helps a user quantify the model by reorganizing the data in pivot tables, and allows a user to find
objects in the model when the data is less than clear on what an object is. See documentation included
with the i-modellmporter for information on how to install and use it.

Clash Detection

The primary tool for clash detection with i-models is Bentley Navigator. See documentation with
Navigator for that process.
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Revit

Setting up Revit to use the Work Structure Content
As of update #3, there is no A/E/C Work Structure content for Revit. Download the latest Revit
templates from the CAD/BIM centers web site at https://cadbim.usace.army.mil.

1. Download the appropriate Revit templates.

i gy ; ==
Q 14| 8B tepr oo manc gyt s a1 Dvicﬁﬁg.hnmmr.. | Fatale
e [3 Yew et ook bep )

5. B Beatey Archteckon o, & Googie S The CADIM Comier. ) Sisgesied 50 =

& CAD-BIM -
TECHNOLOGY CENTER

HOME  ABOUT IS DOCUMENT CENTER  TRAINING  EVENTS/ CALENDAR

W WICTEISE GrAIIC S 0N GRAETSC CONSSIENCY JCI0SS TEams,
destricts and dvisions, Templates wil provide 3 team with a common
tarting peant and will improve th cwerall USACT product and brand

2013 USACE BIM Revit Templates Version 2.2 Jamuary 2015
USACE Revit 2013 Tempdate - AR Dcipines vid

WEACH Ravit 2013 Tamplate - Architectursl v2.2
USACT Ravit 2013 Tamplute - Dectricsl v2.2

USACE Rawit 2013 Template - Mechancal v2.2

T ——— USACE Ravit 2013 Template - Structural v2.2

BIM LINKS

Riws - |

2. Store the Revit templates in a common location.
Note: Do not save the files under Standards, or they will be deleted on the next update to the

Work Structure. The Local Extension folder would be a more appropriate location.

|« Workspace » Extensions » LocalExtension » Search LocalExtension 0
Organize v [@) Open ~ Bum New folder =~ 0 @
Ji AEC_WS_001 “ | Name :
. AEC_Shortcuts

| 7] Local_Profile_For_AEC_WS_001.arg
| USACE_REVIT_ALL Disciplines TEMPLATES v2.2.zip

\. Docs

|| Workspace
|\ Extensions
|| EBES
|\ imodellmporter

| LocalExtension

| Projects E|

|, Standards > ] m »
5 USACE_REVIT_ALL Disciplines_TEMPLATES... Date modified: 12/4/201512:35 PM
‘E zip Archive Size: 0 bytes
Date created: 12/4/201512:35 PM

3. For new projects, create new central models, from the templates, in the projects
../CAD_BIM/_Master_Models/ folder and name the files appropriately.
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Q &A:

Do I Need to Set a User When Opening a File?

TOC

No, the user has been deprecated from the workspace process. It is now set to “untitled” by default and
does not need to be changed. When you select a project, MicroStation Manager will take you to the
CAD_BIM folder of the project and it is assumed you know where to place your files from the

documentation above.

What are Tasks?

The Task menus allow you to focus your tools on the work you are doing.
If you need to place a domestic cold water piping line, select it from the
tool and the Task will place you on the correct level, set you to bylevel
symbology and start the place line tool all in one button click.

Every Task menu now has the General Tasks, for placing annotation, and
the Drawing Tasks, for typical MicroStation tools. If place line isn’t the
tool you need, you can select the main task to set the symbology and
then quickly jump to another tool to place something else.

The Task menus are either loaded via an application when you open the
file or via the menu pull down (AEC Menu -> Tasks). If your file name is
correctly set according to the A/E/C CAD Standards, the Task menu for
that file type will automatically load for you. If your file is not named
appropriately, you can still load the Task menu from the pull down.

What do I do if I Want to Reuse Content in other Projects?
Legacy Content

Contact your local CAD/BIM/ProjectWise Manager to create an extension

2 Piping Plan = S
”\? Piping Plan - |||

EYERVN R
m'if--.

‘\i Drawing

A General

‘\i Domestic Water System == =| =

|'\€ Q Cold water piping

‘\8 ‘W Hot and cold water equipment
‘\i E Eguipment access doors

‘\8 R Domestic filtered water piping
‘\i T Hot water piping

‘\!z A Hot and cold water risers
Floor Information
Graywater System
Laboratory Gas Piping
Medical/Dental Gas Piping
Penetrations

Sanitary Sewer

G| ||| S| S| & | >
Ci[e|([¢||¢||¢| €| ¢

Storm Drainage System

in the Work Structure Extension folder to add legacy content i.e., cells, line styles, fonts to be loaded

from the central location.

Existing CAD Files

It is highly recommended that any new projects use the new seed files and any previous work be
brought up to the latest seed file definition before being used on any new project. To do this:

1. Start with the appropriate new seed file from Workspace/Standards/seed
2. Reference in legacy project data file Coincident World, this will allow MicroStation to take in to

consideration any changes in working units.
3. Merge or copy the desired reference file elements in to master.

Spot check coordinate values and distances to ensure successful conversion.
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Why Don’t We Just Manipulate the Standards Folder?

The Standards folder is developed and maintained by the Workspace Steering Committee. Any changes
made to that folder are very likely to be wiped out by the next Work Structure update. Since the
frequency of the changes is unpredictable, changing those files locally is discouraged.

Files
Where are the seed files?

Sheet Seed: In the Project Dataset - Seed folder.

sheet files: ..\CAD_BIM\Support\Bentley\seed\AEC_sheetSeed.dgn

Design Model Seed: In the Standards Seed folder.
Civil files: ..\Workspace\Standards\seed\AEC_DesignSeed_Horizontal.dgn
Civil files: ..\Workspace\Standards\seed\AEC_DesignSeed_Horizontal_2D.dgn

Building files:  ..\Workspace\Standards\seed\AEC_DesignSeed_ Vertical.dgn
Drawing Model Seed: In the Standards Seed folder.

Civil files: ..\Workspace\Standards\seed\AEC_DrawingSeed_Horizontal.dgn

Building files: ..\Workspace\Standards\seed\AEC_DrawingSeed_Vertical.dgn

Where is the border?
In the General Drawings folder:

ANSI D 34x22 (Typical): ..\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_D.dgn
ANSI F 40x28: ..\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_F.dgn
ANSI E 44x34: ..\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_E.dgn

Where do I Put the Content I Need to Create?

The Project Dataset is under Support in the CAD_BIM folder of the projects. Users should place new
content there.

Annotation/symbols
Where is the title block text?
In the Standards Cell folder: ...\Workspace\Standards\Cell\AEC_TitleBlock.cel

The Cells are placed at either the lower left or lower right corner of the title block. Check with your CAD
Manger for which items are set to use text substitution when plotting the files.

How do I edit a tag?

To edit these tags outside of ProjectWise double click the text field and edit the appropriate tag in the
tag dialog. Inside ProjectWise these fields may be setup to use title block integration where the tag is
bound to a ProjectWise environment variable.
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How do I find Levels more quickly than looking at the level manager?

Right-mouse-press and hold will bring up a menu with Level, Cell and Line Style search tools all of these
tools work very similarly.

1. Select Level Search Wiew Control r
Key-in a word in the search field e.g GAS _ ol .
P, ~—
3. Select Search Coll Saach
The search tool searches in the name and the description of the Line Stye Search

Level, Cell or Line Style.

5

Florw direction arrows

Identifier tags, symbol modifier, and text
Natural gas pping

Valve fvent pitsfraults

Surface markers/sigrs

Coempressor stations

Reduding stations
Tanks

Subeyr face utliies natural gas bresidine
Equipment (pumps, motors, etc.)
Instrumentation (vahves, ste.)
Manhaoles

Equipemsnt

Fiping

Landfil gas

Sod gas

L petrobeum gars

Hatural gas equpment
Hahural gas pping
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Where are the Cells?

Each Cell library is organized by the MasterFormat Division number. Most of the Cell libraries are in the
Standards folder

The Bentley Cell libraries are in the ...\Workspace\Standards\Bentley\cel\
The AutoCAD Block libraries are in the ..\Standards\Autodesk\ACAD\Blocks\

How do I find Cells more quickly than looking at the Cell manager?

Right-mouse-press and hold will bring up a menu with Level, Cell and
View Control r

Line Style search tools all of these tools work very similarly.
Togale Text Mask

1. Select Cell Search

2. Key-in a word in the search field e.g GAS Level Search
3. Select Search | Cell Search
Line Style Search

The search tool searches in the name and or the description
of the Level, Cell or Line Style.

Cell 5earch &3

Search Cell Descriptions for: | GAS Search

Mo Cells Found

Cell Mame | Cell Description Cell Library -
022600-003 Monitoring Probe - Landfill Gas AEC_Divi2 - Existing Conditio|
022600-004 Monitoring Probe - Soil Gas AEC_Div02 - Existing Conditio| =
034800-007 Precast Concrete - Vault - Natural Gas Valve AEC_Div03 - Concrete. cel
104400-003 Fire Prot, - Extinguisher - Dry Chem. - For Liquid - Gas - Or Elec Fires  AEC_Div10 - Spedalties.cel —
231000-004 Piping - Gas Turhine AEC_Div23 - Heating, Ventilat
231100-001 Fire Suppression - LP Gas Shutoff AEC_Div23 - Heating, Ventilat
231100-002 Fire Suppression - Natural Gas Shutoff AEC_Div23 - Heating, Ventilat
235000-001 Heater - Flue Gas Reheater AEC_Div23 - Heating, Ventilat _
S L= T T T o e O P - AT Mo Clmmde mmim O
1| 1 [ 3
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Cell Selector

For a visual method of finding and selecting Cells, Cell Selector menus were created. Cell Selector
menus are accessed from the AEC pull-down menu (AEC Menu -> Tools -> Cell Selector). The menu
either sets the Cell as an Active Cell and/or an Active Pattern.

Text-Dimension Styles

Bra 20 72 B | M (T

AEC_Div01 - General Requirements

AEC_Div02 - Bxisting Conditions

AEC_Div03 - Concrete

AEC Menu | Help
{ Tasks P|v F:).I n - .ﬂ_l n -
| Tools  »| Cel Selector r
| - @ .q‘ Plotting 3
= PW Title Block 3
Ld Viewl, She Reference Caching 3
&~ & @ | Standards & ECBs 3

3

3

MDLs

AEC_Div(4 - Masonny
AEC_Diw05 - Metals
AEC_DiwD6 - Wood, Plastics, Composites
AEC_Div07 - Thermal and Moisture Protection
AEC_Div08 - Openings
AEC_Div(9 - Finishes
AEC_Div10 - Specialties
AEC_Div11 - Equipment

TOC

-
L Cell Selector [\AEC_Div03 - Cun:rete.sql

e

He Edt

033000-001 035000-001 034800-002

cl [F

™

TP

034800-004

T

034100-001 034800-001 034800-003 034800-005 034800-007
< *

034800-006

G

Additionally in the Documentation folder there is a complete list of all of the Cells and line styles in the
libraries: ...\Docs\ AEC_WS_001_Symbols_Guide.pdf. This file describes each Cell, line styles, and
displays how big it should be in your sheet file. For cells, the first line is the name, the second and/or
third lines are the description, and the last line is the scale the Cell is displayed at in that document.

)
i
ois | Comment
081000-001 081000-002 081000-003 031000-004 081000-005
Sxar - Biokdng - Do - Doute ooor - Ooule Egeees [y
12 12 12 12 12
[ — | _—
081000-006 081000-007 081000-008 081000-009 081000-010
Dy = Dt Uarwen: Dicr = Packet Do - Bingie Full Swng. Do - Singin Hrnged O Pwal Docr - Sdng
12 1:2 1:2 1:2 12
r
|
L
- |
081000-011 0B1000-012 083300-001 0B3400-001 033500001
Coor Siideg Surtace Door Unadarcus Doar - Colmg oo Rawaidng Dark Room oo Crvomend
u2 12 12 1:2 12

Note:

Some Cells are meant to be placed using a scale to set the size. E.g. Doors are in inches, so by placing it
at a scale of 36, you will be placing a 36” door. Other Cells, such as a duplex outlet, are meant to be
placed using annotation scale, so you will use the models annotation scale to resize the Cell in your

drawing models.
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How do I find Line Style more quickly than scrolling through Line Style manager?

The Line Styles are organized first by MasterFormat Division number and then alphabetically by
description. The descriptions should provide enough information to tell its purpose.

The Bentley Line Style libraries are in the ...\Workspace\Standards\Bentley\symb\
The Autodesk Line Types libraries are in the ..\Standards\Autodesk\ACAD\LineType\

Like for Levels and Cells, Right-mouse-press and hold will bring up
a menu with Level, Cell and Line Style search tools.

View Control »
Toggle Text Mask

1. Select Line Style Search

) _ ] Level Search
2. Key-inaword in the search field e.g GAS Cell Search
3. Select Search | Line Style Search

The search tool searches in the name and or the
description of the Level, Cell or Line Style.

Line Style Search 2]

Search Line Styles for: | gas Search

Line Syltes Found: 4

Line Style Name

231100-907 Gas - High Pressure
231100-908 Gas - Liguefied Petroleum
231100-909 Gas - Low Pressure
231100-910 Gas - Medium Pressure

How Do I Place Drawing Area Titles?

Select the appropriate Cell for the grid spaces you are using and then snap to the lower left grid
intersection lines. Edit the tags as needed. See the Drawing Area Title tool.

How Do I Place Scales?

Select the appropriate Cell for the scale you are using and snap to the end of the right end of the
Drawing Area Title line.

How do I Place North Arrows?

North arrows are now made of two parts, Plan North and True North. Place the Plan North Cell and then
place the True North Cell at the insertion point of the Plan North Cell. Rotate the True North Cell
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appropriately. If Plan North and True North are the same direction, you can skip placing the True North
Cell.

Why is the KEYIND symbol not 1/4" high per NCS?

The new AEC Key indicator symbol 014200-017 is 9/32” high. We changed the height to allow for two
alpha-numeric characters to be placed in the symbol and still be proportional to the 3/32” text height.
1/4” hexagon would only allow for one character.

Why do some of the Cells not match the NCS?

For the A/E/C CAD Standards, every Cell in the NCS was evaluated against industry standards, such as
ASRAE, NFPA, etc. Where the NCS was not the same as industry standards, the standard setting body
was used to describe the Cell. The NCS will be notified of the errors and it will be up to that body to
correct. Every Cell was gone through to insure that it was proportional to text height where appropriate,
even if the NCS wasn’t. Every Cell was recreated and not just copied from historical NCS data.

See A/E/C Standards Frequently Asked Questions. https://cadbim.usace.army.mil

Miscellaneous
Where do I Find All of the Content That Used to be in the Workspace?

The content that isn’t in the Workspace standards folder has been placed back in the vendor’s hands.
So, AECOsim datasets are now in the Bentley delivered workspace and InRoads data is in the InRoads
delivered workspace.

Why are the Horizontal seed files set to survey feet?

The predominant unit of measure for Civil Works projects in USACE is based on the Survey foot. To
eliminate the need for a GeoPAK specific seed file it was decided to use a common unit of resolution set

to 304800/survey foot.
TOC

What if | am doing work in a state that uses international feet or Metric?

Although the unit of resolution is consistently set to 304800/survey foot, the master units can be
changed to international foot or meters if need be. Organizations that consistently do work in Arizona,
Michigan, Montana, North Dakota, Oregon and/or South Carolina may want to set up a local dataset
that contains copies of the seed files with the master unit changed to international feet and the Work
Structure will continue to work. Organizations that do international work may want to set up a local
dataset that contains copies of the seed files with the master unit changed to meters and the Work
Structure will continue to work. The Line Styles, text styles, dimension styles, and Cells are all set to
operate with annotation scale and will scale appropriately.

The only problems that will be found are if you use GeoPAK and need to change the units of resolution
for the software to operate properly. In that situation, copy the seed files and set the units of resolution
to 304800/foot or 1000000/ meter.
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MicroStation Key-in Reference

Angle

AA= Sets the active angle
Auxiliary Coordinate Systems
AD = Places relative data points

AX = Places absolute data points PX= Deletes an
ACS

RX = Attaches an ACS

SX = Saves the current ACS

Cells

AC = Sets the Active Cell and activates the Place Cell
tool

AP = Sets the active pattern cell

AR = Sets the Active Cell, and activates Place Cell
Relative

CC = Create Cell from fence or selection set

CD = Delete Cell from attached cell library

CM = Creates an array of cells

CR = Rename a cell in the attached cell library

LT = Sets the active line terminator cell

PT = Sets the active point used with the Place Point
command.

RC = Attaches a cell library

Color

CT = Attaches a color table Dimensioning

LD = Sets the level for dimension data

TV = Sets the dimensioning tolerance limits
Element Symbology

CO= Sets the active color

LC = Sets the active line style

WT = Sets the active line weight

Files

EL = Creates an element list file

FF = Copy the contents of a fence to a new or existing
file

RD = Open another design file

RF = Attach a reference file

SF = Move the contents of a fence to a new or
existing file

XD = Exchanges the active file with a reference file
Grid

GR = Sets the active grid reference spacing

GU = Sets the distance of the grid dots in working
units

UR = Sets the unit round off

Line Terminators

LT = Sets the active line terminator cell

TS = Sets the scale factor for the active terminator
Levels

LV = Sets the active level

KY = Sets the key-point snap divisor

A/E/C Users Guide
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OF = Turns levels off

ON = Turns levels on

Patterns

AP = Sets the active pattern cell

PA = Sets the pattern angle for pattern cells

PD = Sets the spacing between patterns

PS = Sets the active pattern scale

Precision Input

DI = Places a data point at a given distance and
direction

DL = Places a data point at a given X, Y and Z
distance along the design axes

DX = Places a data point at a given X, Y and Z
distances along the view axes

XY = Places a data point using absolute coordinate
Scale

AS = Sets the active scale

XS = Sets the active X Scale

YS = Sets the active Y Scale

ZS = Sets the active Z Scale

Stream digitizing

SD = Sets the stream delta

ST = Sets the stream tolerance

Text

DF = Opens the Fonts dialog box

DR = Displays a text file

FT = Sets the active font

LL = Sets the maximum line length for text
LS = Sets the lines spacing for multiple lines of text
NN = Sets the active text node number
TB = Sets the tab spacing when importing text
TH = Sets the text height

Tl = Sets the copy and increment value
TW = Sets the Text Width

TX = Sets both the height and width of the text
View Control

DV = Deletes a named or saved view

RV = Rotates a view

SV = Save a view

VI = Attaches a saved view

WO = Sets the window origin

View Control — 3D

AZ = Sets the active depth - absolute

DD = Changes the display depth - relative
DP = Sets the display depth - absolute

DZ = Sets a new active depth - relative
Miscellaneous
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MicroStation AccuDraw Shortcut Key-Ins

ACCUDRAW
Enter Smart Lock
Space Change Mode

HA AccuDraw on Hold
HS AccuSnap Toggle
HU AccuSnap Suspend

Q Quit AccuDraw
RQ Rotate Quick

X Lock X

Y Lock Y

VA Lock Z

LZ Lock Sticky Z

D Lock Distance
A Lock Angle

LI Lock Index

RE Rotate Element
? Show Shortcuts

- Bump Tool Settings
GT Go to Tool Setting

GK Go to Keyin
GS Go to Settings

VIEW
\" View Rotation
Top Rotation
F Front Rotation

A/E/C Users Guide
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RX
RY
RZ
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Side Rotation

Base Rotation
Cycle Rotation
Rotate View

Rotate about X
Rotate about Y
Rotate about Z

ACS

Rotate ACS

Rotate to Current ACS
Get ACS

Write ACS

Lock ACS Grid Plane
Lock ACS Plane
Lock ACS Plane Snap
SNAPS

Set Origin

Point Keyin (single)
Point Keyin (multi)
Intersect Snap
Nearest Snap
Center Snap

Snap Divisor

TOC
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10

HORIZONTAL ALIGNMENT COORDINATES

POINT TYPE | STATION | NORTHING EASTING
CL EXSTING POV DRIVE
POB 1+00.00 852975.34 1532789.86
POE 3+54.29 853155.48 1532610.38
CL POV ACCESS DRIVE
POB 0+00.00 852747.06 1533021.85
POE 1+20.00 852831.61 1532936.7
SPOT COORDINATES
POINT NO. NORTHING EASTING
1 853154.02 1532661.24
2 853104.48 1532611.78
3 853133.19 1532646.70
4 853270.99 1532785.00
5 853145.43 1532909.33
6 853012.06 1532775.47
7 853012.27 1532767.18
8 852976.62 1532746.23
9 853019.06 1532788.65
10 852973.04 1532825.51
11 852963.31 1532846.66
12 852092.78 1532862.07
13 852992.76 1532870.56
14 853076.55 1532940.48
15 853080.28 1532958.40
16 853039.31 1532917.27
17 852964.10 1532884.06
18 852928.61 1532917.85
19 852950.03 1532910.31
20 852948.41 1532903.45
21 852813.75 1533033.52
22 852841.96 1533033.49
23 852838.45 1533058.31
24 852899.13 1533093.71
25 852886.45 1533106.48
26 852023.14 1533114.97
27 852923.09 1533143.26
28 852964.66 1533101.83
29 852950.55 1533087.66
30 852804.44 1533023.67
31 852831.45 1533029.88
32 852802.61 1532997.13
33 852746.80 1532962.51
34 852916.91 1533111.29
35 852925.59 1533095.78
36 853006.82 1533014.68
37 852098.72 1533039.67
38 853012.83 1533053.84
39 853053.08 1533013.74
40 853038.96 1532999.57
41 852918.09 1532791.56
42 852976.75 1532850.15
43 852798.67 1532928.99
44 852777.33 1532929.06
45 852758.12 1532965.3
46 852819.6 1532999.9
47 852851.14 1533045.54
48 853071.89 1533091.64
49 853143.41 1533043.22
50 853255.1 1533134.02
51 852971.29 1532883.48
52 852955.96 1532892.17
53 852957.84 1532894.06
54 852935.51 1532924.78
55 852027.02 1532924.77
56 852938.47 1532936.26
57 852798.08 1532953.52
58 852865.96 1533057.58
59 852085.28 1533053.05
60 852084.57 1532976.15
61 852984.6 1532962.01
62 852994.8 1532955.24
63 853027.28 1532790.75
64 853103.4 1532697.56
65 853133.24 1532713.33
66 852811.55 1532956.92
67 853069.63 1532924.92
68 853069.55 1532933.46
69 853099.34 1532978.94
70 853143.23 1533068.62
71 853144.13 1532825.85
72 853162.64 1532844.43
73 853166.07 1532841.03
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Change Request, Issue Report and Evaluation Form

Please open the attached form, fill it out, and select the email link at the bottom.
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